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Introduction 

The Douglas Aircraft Company 
 
The Douglas Aircraft Company (DAC) was founded in 1921 by Donald Willis Douglas, Sr. in 
Santa Monica California. The company started out building torpedo bombers for the US 
Navy. Expansion was rapid during the early years and within 5 years of startup the 
company was producing over 100 aircraft annually. 
 
In 1933 DAC produced the DC-1 (Douglas Commercial) in response to a TWA 
(Transcontinental & Western Airlines, later Trans World Airlines) need for a commercial 
transport aircraft to compete with the Boeing 247. Only one prototype of the DC-1 was 
built, but it was soon followed by the DC-2 in 1934 and the now famous DC-3 in 1936. The 
DC-3 is arguably the most significant transport aircraft ever made. More than 16,000 DC-
3s were produced and even today, many DC-3s are still being flown around the world. 
The DC-4 and DC-5 followed in 1939. 
 

World War II 
 
During World War II Douglas produced about 30,000 aircraft, including the C-47 (based 
on the DC-3), A-20 Havoc, A-26 Invader, Dauntless and the B-17 Flying Fortress as a 
partner of the BVD (Boeing-Vegas-Douglas) consortium. 
 

Post World War II 
 
After World War II, Douglas continued work on transport aircraft. The successful four-
engine DC-6 was introduced in 1946 and the last prop-driven commercial aircraft, the 
DC-7 in 1953. 
 
In 1958, Douglas introduced their first jet powered commercial transport aircraft, the DC-
8. The DC-8 was designed to compete directly with the Boeing 707, and even though it 
was launched later than its competitor and almost bankrupted Douglas with escalating 
development costs, it became a huge sales success for Douglas. Over 550 DC-8s were 
produced in total. 
 

DC-9 Launch 
 
The DC-9 series of aircraft was developed to meet the demand for a short-range jet 
airliner and to complement the larger, long-range DC-8. A number of design studies 
were conducted, including a mini DC-8 and a four-engine turbo-prop. Finally, in 1963, 
Douglas launched model 2086; the DC-9. 
 
The decision to launch the DC-9 project was not an easy one for Douglas. The DC-9 was 
an all new design and would enter service after its main competitors, the BAC 1-11 and 
Sud-Aviation Caravelle. Douglas also did not have the minimum firm orders it needed to 
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launch the project at the time. In fact, they did not have any firm commitments. Airlines 
were hesitant to place firm orders until a decision to launch the project was made. 
Nobody wanted to make the first commitment. 
 

Betting the Company 
 
By deciding to launch the DC-9, Donald Douglas essentially “bet the company” on the 
DC-9 and its success. This was the second time Douglas, Sr. had to do this after first 
having “bet the company” on the DC-8. 
 
At the time of the launch Douglas was struggling financially. They had lost military 
contracts and even with a large backlog they were still struggling to recover the cost of 
designing and building the DC-8. Douglas needed an additional $100 million cash flow to 
launch the DC-9. This was the first time that James S. McDonnell approached Douglas 
about a merger. He was quickly turned down. 
 

Risk Sharing 
 
Instead, Douglas took on risk sharing partners to share the production cost and sales 
profits. This solution is commonly used by today’s aircraft manufacturers. About 30 
different external manufacturers were responsible for 45% of the total development and 
production cost, delivering more than 2,500 parts to the DC-9 production line. 
 
The DC-9 has a T-tail configuration and rear-mounted engines, both design features 
shared by its main competitors, the BAC 1-11 and Sud-Aviation Caravelle. Before the 
launch of the DC-9, Douglas entered a partnership with Sud-Aviation to sell the Caravelle 
in North America due to the financial situation at Douglas. This partnership however did 
not work out very well for Douglas which pulled out after only two years. 
 

First Flight 
 
After the launch, the DC-9 sales were a bit slow at first but soon the orders, firm 
commitments and options, were rolling in and production started. The maiden flight took 
place in February 1965. Five aircraft participated in the test program, logging 1,280 flight 
hours. FAA certification was awarded in November 1965, two whole months ahead of 
schedule. 
 

First Service 
 
The first revenue service was flow in November 1965 when a Delta DC-9 had to step in for 
another type on an Atlanta – Memphis service. Delta put the first DC-9 into regular 
service in December 1965, the first flight being a roundtrip from Atlanta to Kansas City. 
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Variations 
 
The DC-9 was designed from the outset with stretched larger capacity developments in 
mind. The DC-9-30, -40 and -50 were stretched and fitted with an enlarged wing to 
handle the larger fuselage. The DC-9-20 had the original -10 fuselage, but was fitted with 
a new wing for increased hot and high performance. 
 

Merger with McDonnell 
 
By 1967 the order book totaled 455 firm orders. However, trouble in the parts supply chain 
caused the production delivery schedule to slip more and more. The Long Beach 
production ramp was filling up with engineless aircraft with incomplete interiors. Douglas 
needed more money to sustain the cash flow. The banks were reluctant to lend the 
money to Douglas and the only alternative left was to seek a merger. A number of offers 
came in, but the DAC board recommended McDonnell’s offer, and that’s how the 
McDonnell Douglas Corporation (MDC) was born. 
 

Legacy 
 
The DC-9 was followed by the MD-80 series in the 1980s, the MD-90 in the 1990s and the 
MD-95, renamed the B717 after the Boeing merger. Total production for the whole DC-9 
family of aircraft totaled over 2,400 aircraft. This makes it the third most successful family 
of airliners behind the Airbus A320 at 4,000 units and the Boeing B737 at 6,000 units. Total 
production of the DC-9 series alone reached 976 aircraft.  
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Get Started! 
 
The first window to pop up when you start the DC-9 Classic for the first time is the Get 
Started window. This window has a brief welcome message for you, but most importantly, 
this window has four links to introduction guides that will get you started flying the DC-9 
Classic in no time at all.  
 

 
 
Introduction guides: 

 
• Flight Center Tour 

Introduces the Flight Center and its features. 
 

• Navigating the Cockpit 
Shows you how to open the various panel windows. 
 

• Cockpit Walkthrough 
Gives you a complete walkthrough and brief explanation of all the switches, 
knobs, levers and handles in the cockpit. 
 

• Tutorial Flight 
This tutorial flight will guide you step-by-step through a complete flight, from 
power on to power off. 

 
If you do not want the Get Started window to pop up every time you start the DC-9 
Classic, simply uncheck the box in the lower right hand side corner. 
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View Menu 
 
In the lower left corner of your screen is a small red square with an white arrow. Move the 
mouse cursor over the red square to open the View Menu. This menu allows you to easily 
access all the windows in the DC-9 Classic panel. Simply click the icon/text of the 
window you wish to open. This will close the View Menu and open the selected window. 
To close the View Menu without selecting a new window, move the mouse cursor over 
the arrow at the top of the menu, or simply move away from the menu and it will 
automatically close after a few seconds. 
 

 

 
• Open the Navigation Simulator 

• Open the Mini Panel 

• Open Circuit Breaker panel U – Z 

• Open Circuit Breaker panel M – T 

• Open Circuit Breaker panel H – L 

• Open Circuit Breaker panel A – G 

• Open Circuit Breaker panel Overhead 

• Open the First Officer’s side panel. 

• Open the Captain’s side panel. 

• Open the Weather Radar panel. 

• Open the Autopilot panel. 

• Open the lower pedestal view. 

• Open the upper pedestal view. 

• Open the upper overhead panel. 

• Open the lower overhead panel. 

• Open the centered main forward panel view. 

• Open the main forward panel view. 

• Open the Speed Cards. 

• Open the checklist. 

• Open the Flight Center. 
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Flight Center 
 
 
The Flight Center is a resource center that houses all the options, training and dispatch 
features. The various sections of the Flight Center are accessed by clicking the main 
menu located on the left hand side. 
 
Flight Center main menu: 
 

• Automatic Aircraft Configuration 
• Training 
• Dispatch 
• Options 
• Failure 
• Push & Start 
• NavSim (Navigation Simulator) 
• Schematics 
• Get Started 

 
All these sections are described in detail on the following pages. 
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Automatic Aircraft Configuration 
 
The Automatic Aircraft Configuration feature is designed to automatically configure the 
aircraft for the flight phase of your choice. Simply select a flight phase in the menu and 
all the buttons, switches, levers and so on in the cockpit will be positioned to suit the 
selected situation. 
 
This feature is useful for both beginners as well as the experienced simmer. Beginners may 
use the Automatic Aircraft Configuration feature for instant flight and fun! Experienced 
simmers may use this feature in part of their training. For example, to practice shooting ILS 
approaches, position the aircraft, hit “Cleared to Land”, and off you go! 
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Available Automatic Aircraft Configuration situations 
 

1. Cold Cockpit – All Systems Off 
Select this situation to turn off all systems in the cockpit. All buttons, switches and 
levers are positioned where you would expect to find them on the first origination 
flight of the day. 
 

2. Ready for Engine Start 
The aircraft has been configured to be ready for engine start. All the pre-flight 
inspections have been done for you. 
 

3. Engines Running – Ready for Push & Taxi 
The engines have been started up for you, and you are ready to depart the gate 
and taxi out to the runway. 
 

4. Cleared for Take-off 
ATC has cleared you for take-off and you are ready for departure. Select this 
auto configuration and the aircraft will be ready to go. 
 

5. Climbout 
Select this configuration and the aircraft will automatically be cleaned up and 
set for cruise climb. 
 

6. Cruising at FL… 
It is time to sit back and get comfortable. You are at your cruising level and the 
aircraft will be configured accordingly. 
 

7. Descending 
Unfortunately, all good things must come to an end – it is time to get back to 
earth. Select this auto configuration to ready the aircraft for the descent into your 
destination. 
 

8. Cleared to Land 
You have received your final approach instructions and you are number one to 
land. Select this configuration just prior to passing the outer marker or final 
approach fix, and the aircraft will be ready for a stabilized approach. 
 

9. Cleanup after Landing 
You just made the smoothest landing ever! Or, at least you’re down. Either way, 
select this configuration to have the aircraft cleaned up and ready for the taxi in 
to your assigned gate. 
 

10. Parking if for the Night 
When you have parked the aircraft safely at the gate and it is time to call it a 
day, select this configuration to turn off and shut down all systems. 
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11. Start APU 
Starts up the APU and connects it to the electrical system. 
 

12. Connect Ground Power Unit 
Plugs in the Ground Power Unit to the aircraft when on the ground and connects 
it to the electrical system. 

 
 
Note for beginners: 
 
You can use the Automatic Aircraft Configuration feature as a checklist help. Think of it 
as your First Officer doing all the administrative work of setting up the aircraft properly for 
the current flight situation. The auto config situations are set up to follow the order of the 
checklists. Simply select the next auto configuration as your flight progresses. 
 
If you simply wish to take the aircraft up for a quick spin right away, select the “Cleared 
for Take-off” configuration and the aircraft will be ready for instant flight! 
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Training 
 
The Training center is the starting point for all interactive training. You will find training 
guides for the checklists, various procedures/operations, cockpit systems, emergency 
and abnormal procedure training, navigation and much more. 
 

 

Checklist 
 
The Checklist guides will show you step by step which procedures to carry out, which 
instruments to check, which switches to set, for each and every item in the checklist. 
 

Procedure 
 
The Procedure guides will guide you through some of the more important procedures 
that you need to be familiar with in order to properly operate the aircraft. The Procedure 
guides will also show you basic operation of some of the more complex cockpit systems. 
 

Emergency 
 
In this section you will find emergency procedure guides, which will show you how to 
properly handle any emergency situation.
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Abnormal 
 
In this section you will find abnormal procedure guides, which will show you how to deal 
with abnormal situations. 
 
Navigation 
 
The Navigation guides will teach you how to navigate the aircraft by radio navigation. 
 

Tips & Tricks 
 
In the Tips & Tricks section you will find various useful guides with tips & tricks on how to 
operate the aircraft, including cockpit walkthroughs and a full tutorial flight. 
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Training Guide 
 
When you select a lesson in the Training center, the Training Guide will appear in the 
lower right hand corner of your screen. The Training Guide takes you step by step through 
all the checklists and procedures required to properly operate the DC-9 Classic. The 
Training Guide will explain to you in detail exactly what to do. 
 
 

 
 
 
The Training Guide box is divided into two main text areas. The upper text area tells you 
which checklist item or procedure step is currently being explained. The lower text area 
tells you exactly what to do in order to accomplish the current checklist item or 
procedure step. 
 
At the bottom of the Training Guide box are a number of buttons which allow you to 
navigate through the checklist/procedure. 
 

 

Close the Training Guide. 

Go back to the Flight Center. 

Restart the lesson. 

Start the Training Editor. 

Go back to the previous checklist item or procedure step. 

Go to the next checklist item or procedure step. 
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The Training Guide uses yellow arrows and boxes to help you locate the various switches, 
buttons, levers, and instruments described in the Training Guide box. The Training Guide 
will also automatically open the appropriate panel view where the described switch or 
gauge is located. 
 
 
Screenshot showing an example of the training arrows and boxes: 
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Dispatch 
 
In the Dispatch center you can set up the loading of the aircraft. You can select the 
number of passengers  and amount of cargo you will be transporting, as well as the fuel 
load needed for the planned flight. In the Dispatch center you can also print out a 
departure plan with a complete loadout summary. 
 

 
 

PAX & Cargo 
 
Use the Plus, Minus, Empty, Full and Random buttons on the right to set the passenger 
and cargo load. Note that while only the amount of passengers is displayed, cargo is 
added in relation to how many passengers are onboard. 
 
Click the upper right corner tab to access a more detailed view of the passenger and 
cargo loading. In this detailed view you can specify your passenger and cargo load in 
detail. Click the various plus and minus buttons to set the cargo. 
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Fuel 
 
Use the Plus, Minus, Empty, Full and Random buttons to set the fuel load. The two main 
wing tanks are always filled up before the center tank. This is due to the fact that the 
engines on the DC-9 are only able to gravity feed from the main tanks. If all fuel boost 
pumps fail, fuel in the center tank cannot be used. 
 
Click the upper right corner tab to access a more detailed view of the fuel load. In this 
detailed view you can you can specify your fuel load in more detail. Click the various 
plus and minus buttons to set the fuel load. 

Summary 
 
The loadout summary is a compacted version of the departure plan where you will find 
all the relevant preflight data for your flight. The departure plan is described in detail later 
in this manual. 
 
Click the 0, 5 and 15 degree signs on the right to select your takeoff flaps setting. 

Right Side Buttons 
 
Located on the lower right hand side of the Dispatch Center are three buttons: 
 
 
 

 

• Weight & Balance Control Form 
Press this button to open the Weight & Balance 
Control Form.  
 

• Print Departure Plan 
If you have a printer connected to your 
computer, you can press this button to print out a 
Departure Plan. A Departure Plan based on the 
numbers you have set in the Dispatch center will 
be saved to a text file and opened in Notepad 
for printing. The departure plan is stored as a file 
called “Departure plan.txt” in the 
“\FSX\SimObjects\Airplanes\F1 DC-9” folder. It 
will overwrite any previous departure plans. 
 

• Update 
Press this button to update the simulator with the 
passenger, cargo and fuel load you have 
selected. If you exit the Dispatch center without 
pressing the Update button, the changes you 
made in the Dispatch center will not be reflected 
in the simulator. 



User Manual 
Page 19 
 

 

DC-9 Classic – User Manual 
 
 

Departure Plan 
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1. Departure station, Flight number, Aircraft number, Take-off FLAP setting plan is 

based on, date and time. 
 
2. Temperature and pressure setting at field elevation. 
 
3. Planned Take-off Weight (PTOW) is Take-off Weight (TOW) from load planning 

section rounded down to next whole hundred pounds. 
 
4. Aircraft and engine type. 

 
5. Runway Take-off Power Setting (TPS) Section. Power and V-speed setting for 

Reserve Take-off thrust, Maximum Take-off thrust and Standard Take-off thrust. 
 

6. Quick summary of load closeout section. Take-off Weight Center of Gravity (TOW 
CG), total fuel, Zero Fuel Weight (ZFW) and stabilizer trim setting (STAB). 

 
7. Manual Load Closeout data entry field. 

 
8. Load Plan Section. 

EOW Empty Operating Weight 
PSGR WT Passenger weight 
CGO WT Cargo weight 
BALLAST Ballast weight 
ZFW Zero Fuel Weight 
FUEL Total fuel weight 
RMP Ramp weight (Total weight of aircraft on the ramp) 
TXI Taxi fuel weight (Estimated fuel used to taxi before takeoff) 
TOW Take-off Weight (Total weight of aircraft at take-off) 
MZFW Maximum Zero Fuel Weight 
MRMP Maximum Ramp Weight 
MTOW Maximum Take-off Weight 
F1 Forward Cargo Compartment 1 
A1 Aft Cargo Compartment 1 
FLAPS Take-off flaps setting 
TEMP Current temperature 
TOW CG Take-off Weight Center of Gravity 
STAB Stabilizer trim setting 
CNFIG Current aircraft configuration (max 101 passengers) 
PSGRS Passengers on board (101 passengers) 
 

9. Landing Data Section. 
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Options 
 
Various options to customize your cockpit environment and training are available in the 
Options center. Simply click the box/alternative to set the option. 
 

 
 

Available options: General 
 

• Use spacebar to step through checklist 
With this option enabled, you can use the spacebar to step through the checklist. 
Simply press the spacebar and your First Officer will read the next item on the 
checklist for you. Note that you do not need to have the checklist displayed on 
the screen for this feature to work. 

 
• Pop-up Annunciator Panel 

If you check this option, the Overhead Annunciator Panel will pop up 
automatically every time a new caution or warning alert is issued. This allows you 
to instantly see which system triggered the caution or warning alert. 
 

• Show Menu 
Set the display option, display or hide, for the lower left corner View Menu. 
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• No APU Delays 

When this option is selected, the normal delays in starting and stopping the APU 
are removed to make it immediately available. 
 

• Dynamic Shadows 
Select this option to remove the dynamic shadows that are located around 
various instruments and gauges in the 2D cockpit. This will boost your frame rate 
performance at the expense of a more realistic view. 
 

• No failures loaded on startup 
Check this option to always start your flight without any leftover failure situations 
from the previous flight. 
 

• Enable FSX GPS 
With this option enabled, the FSX default Garmin 500 GPS can be used for 
navigation. In the 2D cockpit, the two buttons on the glareshield directly above 
the Flight Mode Annunciator are activated. The left button opens and closes the 
GPS window. The right button enables/disables GPS navigation using the 
autopilot. This is only available in the 2D cockpit. 
 

• 2D panel ADF doubles as ADF1/ADF2 
Enabling this option gives you access to two ADF units. The ADF on the 2D panel 
pedestal, which is normally ADF1, doubles as the front for both ADF1 and ADF2 
when this option is enabled. A number in the upper right hand side corner of the 
ADF unit indicates which ADF unit is being displayed and manipulated. Click the 
number to switch between ADF1 and ADF2. This feature, and ADF2, is only 
available in the 2D panel. The ADF unit in the virtual cockpit is always ADF1. 
 

• 2D panel HSI displays NAV1/NAV2 data 
Enabling this option gives you access to NAV2 on the Captain’s HSI. A number in 
the upper right hand side corner of the HSI unit indicates which NAV unit is being 
displayed and manipulated. Click the number to switch between NAV1 and 
NAV2. 
 

• Automatic palm switches on go-around 
Regular computer joysticks do not have palm switches like the real DC-9 throttle 
handles do to engage go-around mode on the Speed Command system. To 
overcome this limitation, the DC-9 Classic will by default automatically engage 
go-around mode when a go-around situation is detected. For enhance realism 
you can disable this automatic feature and engage go-around manually. By 
default, the palm switches are mapped to SHIFT-X, but you can change this to 
any key combo you like in the KeyboardInput.ini file located in the aircraft folder. 
 

• Display metric values (2D panel only) 
With this option enabled, the 2D panel will display metric values for weights and 
temperature. Note that this option works for the 2D panel only. The virtual cockpit 
will always display imperial (US) values. 
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Available options: Messages 
 

• Open Flight Center at startup 
Check this option if you would like to have the Flight Center show up every time 
you start the DC-9 Classic. 
 

• Show Get Started window at startup 
When this option is checked, the Get Started window will be displayed every time 
the panel is loaded. 
 

• Show Dispatch Center Updated message 
When this option is checked, a message box will appear when you click the 
update button in the Dispatch Center to confirm the simulator has been updated 
with the new values you have set for passengers, cargo and fuel. 
 

• Show Dispatch Center Not Updated message 
When this option is checked, a message box will appear when you attempt to 
leave the Dispatch Center without having updated FSX with the changes you 
made to fuel and payload. The changes you make on the Dispatch page are not 
loaded into FSX until you click the Update button in the lower right corner. 
 

• Show Failure Scenario Loaded dialog box 
When this option is checked, a message box will appear when you click to load a 
failure scenario, confirming the failure triggers associated with that failure 
scenario have been set and activated. 
 

• Show New Display Format message 
When this option is checked, a message box will appear when you change the 
display format of the 2D panel to remind you to reload the aircraft. 
 
 

Available options: Sound 
 

• Panel sounds 
Setting this option turns off all sounds related directly to the panel. Other sounds 
like engine noise, gear rumble and radio transmissions are not affected. These 
sounds will have to be turned off through the MSFS menu. Note that the default 
MSFS keyboard shortcut to turn off sound is the Q key on the keyboard. 

 
• First Officer voice 

Select this option to toggle on/off all the First Officer callouts. 
 
• Click sounds 

Select this option to toggle on/off the click sounds on all the switches and knobs. 
 
• Panel sound volume 

Drag the slider to adjust general panel sounds volume. 
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• First Officer voice volume 
Drag the slider to adjust First Officer’s voice audio volume. 

Available options: Help 
 

• Show hotspots 
A hotspot is a clickable area which, when clicked, will bring up a new panel or 
window. It is a sort of shortcut that makes panel and window navigation easier 
and faster. Hotspots are normally not visible. Select this option to have all the 
hotspots in the panel indicated by yellow boxes. 
 

• Show click areas 
Select this option to have all the click areas in the panel indicated by magenta 
boxes. 
 

• Show circuit breaker visual aid 
Check this option to display the circuit breaker visual aid, in which colors indicate 
the condition of each breaker. A green light indicates the breaker is in (working), 
while a red light indicates it is out (tripped). 
 

• Use Alternative Training Guide Font 
If the default text/font is invisible in the training guide, select this option to switch 
to an alternative font. 

 
 

Available options: Display 
 

• Standard 4:3 format 
Select this option to display the 2D panel in standard 4:3 format. The aircraft must 
be reloaded before the display format change becomes effective. Note that the 
panel.cfg file is overwritten when changing this option. 
 

• Widescreen 16:9 format 
Select this option to display the 2D panel in 16:9 widescreen format. The aircraft 
must be reloaded before the display format change becomes effective. Note 
that the panel.cfg file is overwritten when changing this option. 

 



User Manual 
Page 25 
 

 

DC-9 Classic – User Manual 
 

Coolsky, 2012. 

  
 

Failure 
 
The Failure center allows you to set a number of random or planned failures to occur 
during your flight. You can select individual specific failures to occur or you can select 
scenarios that include multiple failures combined to simulate various real world situations. 
In the Failure center, you can also select scenarios that introduce failures with a very low 
chance of something happening, simulating real world daily operation where usually 
nothing major happens, but you might have a snag or two. 
 

Scenario 
 
The scenario section lists all the available failure scenarios. From this section you can load 
a scenario by clicking on it. All the scenarios are listed with a title and a short description. 
The checkbox on the right will indicate which scenario is currently loaded. The buttons on 
the left side allow you to alter existing scenarios or create new ones. 
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Menu Buttons 
 

• Clear All 
Removes all failure situations. No active failures are left after clicking this button. 

 
• Save As 

Saves the current set of active failure situations, as set under the Emergency and 
Abnormal tabs, as a new scenario. A dialog box will open and allow you to enter 
the filename for the new scenario. The scenario setting file will then open in a text 
editor, allowing you to edit the scenario title and description which is displayed in 
the Failure center. 

 
• Edit 

Opens a failure scenario file for editing in a text editor. Before editing an existing 
file, however, it is suggested that you copy that file and then edit the copy. 
 

• Reset Triggers  
Resets the triggers in all active scenarios. 
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Emergency 
 
The Emergency section contains all the emergency failure situations. These include 
powerplant, fire and smoke, and various other emergencies such as rapid 
decompression and complete loss of AC power. 
 

 
 
You select the emergency sub-category on the left and then all the failure situations in 
the sub-category are listed. All listed failure situations include a title on the first line, a 
description of the triggering situation on the second, and a checkbox indicating whether 
the item is active or not. 
 
In the sample Fire & Smoke Emergency shown above, the trigger situation description 
includes: 

1. Trigger situation (Altitude above) 
2. Parameter for the trigger situation (10000) 
3. Delay time (00:01:00, one minute) 
4. Delay type (Absolute) 
5. Probability (100%) 

 
The above described situation means that smoke will occur in the cockpit, with 100% 
certainty, exactly one minute after climbing above 10,000 feet. 
 
Click on a failure item to activate it. If a trigger has been set already for the item, it will 
activate immediately. If a trigger has not been set, the Failure Editor dialog box will open. 
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Training Editor 
 
The Training Editor allows you to specify in detail exactly when a failure situation should 
be triggered during the flight. 
 
The Failure Editor has a title on top to indicate which failure situation is currently being 
edited. On the left are the trigger parameter names. In the center you find the trigger 
parameter values, along with circled minus/plus/dot click areas to change the 
parameter values. On the right you have a context-sensitive trigger parameter menu. 
The quick select menu will change values depending on which trigger parameter you 
hover the mouse cursor over. 
 
 

 
 
 

Training Editor Parameters 
 

• Trigger  
Indicates the situation that will start the emergency. Triggers can be related to 
altitude or airspeed, or to specific pilot actions such as extending the flaps. 
 

• Parameter  
Some triggers require a numerical value. Examples of such parameter-based 
triggers include an altitude above 21,000 ft MSL or an airspeed below 180 KIAS. 
 

• Delay  
You can specify how much time elapses between the trigger and the start of the 
emergency. 
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• Delay Type  
The Delay Type can be set to Absolute or Random. Absolute will trigger the failure 
exactly at the time specified in the Delay parameter. Random introduces an 
element of unpredictability. With the Random parameter, the failure situation will 
occur sometime between zero seconds and the time specified in the Delay 
parameter. For example, suppose the Trigger has been set to Speed above, the 
Parameter is 250, the Delay is 3:00, and the Delay Type is Random. This means the 
emergency will start sometime in the first 3 minutes after the airspeed has 
exceeded 250 KIAS. 
 

• Probability  
This is another parameter that introduces an element of unpredictability. 
Probability specifies the probability of the failure situation actually occurring when 
the trigger situation has occurred and the delay has elapsed. 
 

• Active  
Indicates whether the current failure situation’s trigger is active or not. In the 
previous example, suppose you set a Probability value of 20%. That means there is 
a 20% chance the emergency will start sometime in the first 3 minutes after the 
airspeed has exceeded 250 KIAS. If you leave this failure active over a number of 
flights, then on average it will occur on 1 out of every 5 flights. 
 

 

Training Editor Buttons 
 

• Random  
Randomly sets all the Training Editor parameters and activates the failure. 
 

• Clear  
Resets all the Training Editor parameters and deactivates the failure. 
 

• Load  
Loads the set parameters into the sim and closes the Training Editor. 
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Abnormal 
 
As the name implies, an Abnormal situation is one that is not normal. Unlike Emergencies, 
Abnormal failures don't pose an immediate threat to the flight although some may 
quickly escalate to an Emergency if you don't respond correctly. They range from 
relatively minor annoyances, such as a faulty light or small fuel leak, to near-emergency 
situations like a cracked windshield or a landing gear lever that won't move. Almost 
every major aircraft system is included in the Abnormal section. Abnormal failures are 
created or edited using the same options as the Emergency failures discussed earlier. 
 

 
 
 
Note the green corners on the various tabs in the above screenshot. A green corner on a 
tab indicates one or more failures are active under that tab. This way you can easily find 
and edit or toggle on/off the active failure situations. 
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Ground Operations 
 
In the Ground Operations center you will find two sub sections; the Pushback & Engine 
Startup section, and the Doors, Exits and Air Stairs section. 
 

 
 
 

Pushback & Startup 
 
In the Pushback & Startup section you have the option to select and initiate pushback 
from the gate or stand, startup of the engines, or both pushback and startup. Your First 
Officer will contact the ground crew and initiate the selected action. 
 
 

Doors, Air Stairs and GPU 
 
This section allows you to open/close all the cargo doors, exits and air stairs modeled on 
the external aircraft model. The available animated parts are marked in light grey when 
closed and green when open. Click directly on the aircraft and the door or air stair you 
wish to open/close. You can also connect the Ground Power Unit (GPU) to supply power 
to the aircraft while on the ground. 
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Navigation Simulator 
 
The Navigation Simulator is a tool to help you learn and better understand the ins and 
outs of radio navigation. It uses a moving map display to show your position relative to 
the VORs and NDBs around you. Options allow you to show your current heading, your 
planned flight plan, your actual flight path, bearings and distances from selected station, 
and much more. 
 

 
 

 
The Navigation Simulator is very closely linked to the navigation instruments in the cockpit 
to make this an integrated learning experience. When you change the course on the 
HSI, you also change the course on the Navigation Simulator needle. When you click to 
select a VOR or NDB station in the Navigation Simulator, the frequency is automatically 
set on the NAV radio or ADF control panel as appropriate. You can align the Navigation 
Simulator to the aircraft heading so the Navigation Simulator shows exactly the same 
thing as the HSI or RMI. 
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Menu 
 
Center 

• Aircraft 
Puts the aircraft position in the center of the display. 
 

• Station 
Puts the currently selected navaid in the center of the display. 
 

• User 
Drag the display to any position you want. Note: User position cannot be used 
together with Aircraft heading. If Aircraft heading is active, selecting this option 
will automatically switch the display to Mag North heading. 
 

Heading 
• Aircraft 

Orients the display so the aircraft’s heading is up. If the aircraft turns, the display 
will rotate. Note: Aircraft heading cannot be used together with User center 
position. If User position is active, selecting this option will automatically switch the 
display to Aircraft center position. 
 

• Mag North 
Orients the display so that magnetic north is always up. 
 

• True North 
Orients the display so that true north is always up. 
 

Range 
• 10 NM 
• 20 NM 
• 40 NM 
• 80 NM 
• 160 NM 
• 320 NM 
• 640 NM 

Set the range, or zoom level, to display. You can use the mouse wheel to zoom in 
and out while hovering the mouse of the display. 
 

Display 
• Airport 

Shows/hides airports on the display. 
 

• VOR 
Shows/hides VOR stations on the display. 
 

• DME 
Shows/hides DME stations on the display. 
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• NDB 
Shows/hides NDB stations on the display. 
 

• Waypoint 
Shows/hides waypoints on the display. 
 

• Labels 
Shows/hides labels on airports, VORs, DMEs, NDBs, and waypoints. Waypoint 
labels are only show when the range is 40 NM or less. 
 

• Isolate 
Isolates the currently selected navaid on the display by hiding all other navaids. 

 
• Nav Lines 

Shows/hides the navigation helper lines. The helper lines display courses, 
headings, bearings and radials. 
 

• HSI 
Shows/hides the compass rose and needle on the display. 
 

• Wind 
Shows/hides wind information in the display’s upper right corner. 
 

• Nav Info 
Shows/hides various navigation information in the display’s lower left corner. 
 

• AC Info 
Shows/hides various aircraft-related information in the display’s lower right corner. 
 

• Night Mode 
Inverts the colors from black on white, to white on black. 

 
Flight Plan 

• Load 
Open and load an FSX flight plan for display on the Navigation Simulator. 
 

• Hide 
Temporarily hide the currently loaded FSX flight plan from the display. 

 
Options 

• Auto-tune 
Automatically tune the selected station on the appropriate radio. 
 

• Clear Track 
Permanently clear the ground track data to this point. 
 

• Hide Track 
Temporarily hide the ground track from the display. 
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Schematics 
 
The schematic drawings allow you to clearly see how a few of the most important 
aircraft systems function. As you learn more about those systems, you will find that 
everyday procedures and checklists make more sense. And should you find yourself in an 
emergency or abnormal situation, that knowledge will help you understand what is 
happening and how it can be fixed. 
 

 
 
 
Five schematics are included: 
 

1. Electrical 1: AC 
2. Electrical 2: DC 
3. Fuel 
4. Hydraulic 
5. Pneumatic 

 
All the schematics are tied in with the aircraft systems and actually reflect the current 
state of the aircraft. If you close a circuit or open a valve in the cockpit, it is reflected in 
the schematics. If you do the same in the schematics, where interaction is available, it’s 
reflected in the cockpit. 
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Checklist 
 
 
A Checklist is available via the View Menu and a panel hotspot. This checklist covers 
normal procedures. 
 
Available checklists are: 
 

• Safety and Power On 
• Originating/Receiving 
• Before Start 
• After Start 
• Before Takeoff 
• After Takeoff 
• Preliminary Landing 
• Landing 
• After Landing 
• Parking and Securing

 
 

 
Click the checklist title area to flip through the various checklists. Click the bottom box 
marked ‘Next Item’ to step through the checklist. 
 
As you advance through the checklist the current item will be highlighted in gray. Each 
item on the checklist is read out loud by your First Officer. You can also press the 
spacebar key to advance through the checklist. 
 
Note that you do not need to have the checklist visible in order to advance through the 
checklist items with the spacebar. Simply hit the spacebar and your First Officer will read 
the items in the checklist out loud for you. This allows you to focus on performing the items 
in the checklist. The spacebar feature can be disabled in the Options window if required 
or you can change the keyboard key assigned to this task. There is also a hotspot on the 
main panel you can click to step through the checklist. 
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Speed Cards 
 
 
A Speed Cards is available in the View Menu and via a panel hotspot. The Speed Cards 
provides two sets of quick reference speed cards. 
 

• Takeoff – for takeoff and climbout speeds 
• Landing – for approach and landing speeds 

 
 

 
 
 
Click areas are marked in light grey. 
 
Click the header to switch between the two sets of speed cards. 
 
Click the weight to set the approximate weight of the aircraft. All speeds have a margin 
calculated into them – the nearest weight, rounding up or down, will suffice. 
 
At the bottom of the speed cards are three boxes: 0°, 5° and 15° for takeoff, and 25°, 40° 
and 50° for landing. These numbers indicate the flap setting for landing and takeoff. 
Select your flap setting and click the appropriate box to transfer the four speeds 
indicated by the black arrow heads, to the four bugs on your Airspeed Indicator gauge 
for reference during landing and takeoff. 
 
For landing, the top three numbers and one of the numbers indicated by the three lower 
black arrow heads will be transferred to the ASI, depending on the selected flap setting. 
 
Speed(s) you will need during an emergency or abnormal situation are highlighted in 
light red (V2 and VGA5). 
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Keyboard Input 
 
 
You can use your keyboard to access all of the custom click areas in the panel. You can 
manually assign a keyboard key combination to any click area by editing the 
KeyboardInput.ini file located in the aircraft folder: “FSX\SimObjects\Airplanes\F1 DC-9”. 
 
Before you start using and assigning key combinations to the click areas you need to 
enable this feature. Edit the KeyboardInput.ini file to enable keyboard key combinations 
click area access. 
 
Open the KeyboardInput.ini file and locate this section: 
 
[KEYBOARD COMBOS] 
Enabled=0 
 
Set Enabled=1 to enable keyboard key combinations to access click areas. 
 
Only the “checklist next” click area has a key combination already assigned to it. You 
have to manually set the key combinations for the click areas you wish to use. 
 
For each click area you can specify up to 4 keys in a single keyboard key combination. 
 
Some of the valid keys are: 

• 0-9 
• A-Z 
• CTRL 
• SHIFT 
• ALT 
• SPACE 
• F1-F12 

 
Example: CTRL+ALT+1+Q. 
 
NOTE: You can only assign key combinations that are not already in use in FSX. If your 
chosen key combination is not working, there is a good chance it’s already assigned in 
FSX. If you wish to use one of the default keyboard assignments in FSX, remove the 
assignment in FSX first. 
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Full list of available keyboard input keys (according to the FSX SDK): 
 
“VK_0x00”  
“VK_LBUTTON”  
“VK_RBUTTON”  
“Scroll_Lock”  
“VK_MBUTTON”  
“VK_XBUTTON1”  
“VK_XBUTTON2”  
“VK_0x07”  
“Backspace”  
“Tab”  
“VK_0x0A”  
“VK_0x0B”  
“Num_5”  
“Enter”  
“VK_0x0E”  
“VK_0x0F”  
“Shift”  
“Ctrl”  
“Alt”  
“VK_PAUSE”  
“Caps_Lock”  
“VK_KANA”  
“VK_0x16”  
“VK_JUNJA”  
“VK_FINAL”  
“VK_KANJI”  
“VK_0x1A”  
“Esc”  
“VK_CONVERT”  
“VK_NONCONVERT”  
“VK_ACCEPT”  
“VK_MODECHANGE”  
“Space”  
“Num_9”  
“Num_3”  
“Num_1”  
“Num_7”  
“Num_4”  
“Num_8”  
“Num_6”  
“Num_2”  
“VK_SELECT”  
“VK_PRINT”  
“VK_EXECUTE”  
“Sys_Req”  
“Num_0”  
“Num_Del”  
“VK_HELP”  
“0”  
“1”  
“2”  
“3”  
“4”  
“5”  
“6”  
“7”  
“8”  
“9”  
“VK_0x3A”  
“VK_0x3B”  
“VK_0x3C”  
“VK_0x3D”  
“VK_0x3E”  
“VK_0x3F”  

“VK_0x40”  
“A”  
“B”  
“C”  
“D”  
“E”  
“F”  
“G”  
“H”  
“I”  
“J”  
“K”  
“L”  
“M”  
“N”  
“O”  
“P”  
“Q”  
“R”  
“S”  
“T”  
“U”  
“V”  
“W”  
“X”  
“Y”  
“Z”  
“VK_LWIN”  
“VK_RWIN”  
“VK_APPS”  
“VK_0x5E”  
“VK_SLEEP”  
“VK_NUMPAD0”  
“VK_NUMPAD1”  
“VK_NUMPAD2”  
“VK_NUMPAD3”  
“VK_NUMPAD4”  
“VK_NUMPAD5”  
“VK_NUMPAD6”  
“VK_NUMPAD7”  
“VK_NUMPAD8”  
“VK_NUMPAD9”  
“VK_MULTIPLY”  
“VK_ADD”  
“VK_SEPARATOR”  
“VK_SUBTRACT”  
“VK_DECIMAL”  
“VK_DIVIDE”  
“F1”  
“F2”  
“F3”  
“F4”  
“F5”  
“F6”  
“F7”  
“F8”  
“F9”  
“F10”  
“F11”  
“F12”  
“F13”  
“F14”  
“F15”  
“F16”  

“F17”  
“F18”  
“F19”  
“F20”  
“F21”  
“F22”  
“F23”  
“F24”  
“VK_0x88”  
“VK_0x89”  
“VK_0x8A”  
“VK_0x8B”  
“VK_0x8C”  
“VK_0x8D”  
“VK_0x8E”  
“VK_0x8F”  
“Pause”  
“VK_SCROLL”  
“VK_OEM_FJ_JISHO”  
“VK_OEM_FJ_MASSHOU”  
“VK_OEM_FJ_TOUROKU”  
“VK_OEM_FJ_LOYA”  
“VK_OEM_FJ_ROYA”  
“VK_0x97”  
“VK_0x98”  
“VK_0x99”  
“VK_0x9A”  
“VK_0x9B”  
“VK_0x9C”  
“VK_0x9D”  
“VK_0x9E”  
“VK_0x9F”  
“VK_LSHIFT”  
“VK_RSHIFT”  
“VK_LCONTROL”  
“VK_RCONTROL”  
“VK_LMENU”  
“VK_RMENU”  
“VK_BROWSER_BACK”  
“VK_BROWSER_FORWARD”  
“VK_BROWSER_REFRESH”  
“VK_BROWSER_STOP”  
“VK_BROWSER_SEARCH”  
“VK_BROWSER_FAVORITES”  
“VK_BROWSER_HOME”  
“VK_VOLUME_MUTE”  
“VK_VOLUME_DOWN”  
“VK_VOLUME_UP”  
“VK_MEDIA_NEXT_TRACK”  
“VK_MEDIA_PREV_TRACK”  
“VK_MEDIA_STOP”  
“VK_MEDIA_PLAY_PAUSE”  
“VK_LAUNCH_MAIL”  
“VK_LAUNCH_MEDIA_SELECT”  
“VK_LAUNCH_APP1”  
“VK_LAUNCH_APP2”  
“VK_0xB8”  
“VK_0xB9”  
“VK_SEMICOLON”  
“VK_PLUS”  
“VK_COMMA”  
“VK_MINUS”  
“VK_PERIOD”  
“VK_SLASH”  

“VK_TILDE”  
“VK_0xC1”  
“VK_0xC2”  
“VK_0xC3”  
“VK_0xC4”  
“VK_0xC5”  
“VK_0xC6”  
“VK_0xC7”  
“VK_0xC8”  
“VK_0xC9”  
“VK_0xCA”  
“VK_0xCB”  
“VK_0xCC”  
“VK_0xCD”  
“VK_0xCE”  
“VK_0xCF”  
“VK_0xD0”  
“VK_0xD1”  
“VK_0xD2”  
“VK_0xD3”  
“VK_0xD4”  
“VK_0xD5”  
“VK_0xD6”  
“VK_0xD7”  
“VK_0xD8”  
“VK_0xD9”  
“VK_0xDA”  
“VK_LBRACKET”  
“VK_BACKSLASH”  
“VK_RBRACKET”  
“VK_QUOTE”  
“VK_0xDF”  
“VK_0xE0”  
“VK_OEM_AX”  
“VK_OEM_102”  
“VK_ICO_HELP”  
“VK_ICO_00”  
“VK_PROCESSKEY”  
“VK_ICO_CLEAR”  
“VK_PACKET”  
“VK_0xE8”  
“VK_OEM_RESET”  
“VK_OEM_JUMP”  
“VK_OEM_PA1”  
“VK_OEM_PA2”  
“VK_OEM_PA3”  
“VK_OEM_WSCTRL”  
“VK_OEM_CUSEL”  
“VK_OEM_ATTN”  
“VK_OEM_FINISH”  
“VK_OEM_COPY”  
“VK_OEM_AUTO”  
“VK_OEM_ENLW”  
“VK_OEM_BACKTAB”  
“VK_ATTN”  
“VK_CRSEL”  
“VK_EXSEL”  
“VK_EREOF”  
“VK_PLAY”  
“VK_ZOOM”  
“VK_NONAME”  
“VK_PA1”  
“VK_OEM_CLEAR”  
“VK_0xFF”
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Navigation Data 
 
 
The DC-9 Classic comes with a full navaid data base supplied by Navigraph for use in the 
Navigation Simulator. The navaid data base includes the following data: 
 

• Airport data 
• VOR data 
• DME data 
• NDB data 
• Waypoint data (intersections) 

 
The navaid data covers the whole world. 
 
The navigation data supplied with the DC-9 Classic is of an older AIRAC cycle. The latest 
AIRAC cycle can be bought from Navigraph (www.navigraph.com). 

http://www.navigraph.com/�
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ICTS Editor 
 
 
The ICTS Editor (Integrated Cockpit Training System) is used to create and edit training 
lessons for use with the DC-9 Classic ICTS. The ICTS Editor is a standalone program which 
can be run independently of FSX. 
 
 

 
 
Lesson Title 
This is the title that will appear in the Flight Center Training section in the simulator. 
 
Lesson Type 
This specifies which category the lesson will appear under in the Flight Center Training 
section. 
 
Lesson File 
This box specifies the path and filename of the lesson file. 
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Number 
These numbers indicate the step number of the lesson step currently in view and the total 
steps in the lesson. Use the arrow buttons to navigate forward or backward through the 
lesson steps. The NEW button inserts a new lesson step after the current step. The DELETE 
button deletes the current lesson step. CLEAR will erase all the data entered for the 
current step. 
 
Header 
This is the header that will appear in the training guide box. Each step may have its own 
header. Note that you must manually break the lines yourself and make sure that the 
header fits within the header text area in the editor. This area corresponds to the 
available area in the training guide in the simulator. 
 
Text 
This is the lesson text that will appear in the training guide text area. Note that you must 
manually break the lines yourself and make sure that the text fits within the text area in 
the editor. This area corresponds to the available area in the training guide in the 
simulator. 
 
Window 
From this dropdown menu, you can select which panel window the training guide will 
open for this lessons step. 
 
Arrows 
For each lesson step you can insert yellow arrows on the screen as visual aids to the text 
in the training guide. The dropdown menu specifies the arrow type (left, right, upper, 
lower). The text specifies the direction in which the arrow is pointing. The X and Y boxes in 
the editor can be used to specify the X,Y coordinates for the arrow’s position on the 
screen. You may set up to 4 arrows for each lesson step. 
 
Boxes 
For each lesson step you can insert yellow boxes on the screen as visual aids to the text in 
the training guide. The dropdown menu specifies the box type. A selection of boxes with 
varying shapes and sizes are available.  The X and Y boxes in the editor can be used to 
specify the X,Y coordinates for the box’s position on the screen. You may set up to 4 
boxes for each lesson step. 
 
Bottom buttons 
NEW Clears all the data in the ICTS Editor. 
OPEN Opens up a dialog to open a previously created lesson file. 
SAVE Saves the current lesson to file. 
SAVE AS Opens up a save dialog where you can specify the path and filename of the 

file you want the lesson to be saved to. All lessons are saved as .ICTS files. 
EXIT Closes the ICTS Editor. 



User Manual 
Page 42  

DC-9 Classic – User Manual 
 

Coolsky, 2012. 

Additional Product Notes 
 

Hardware Requirements 
 
The DC-9 Classic will run fine on any computer capable of running FSX itself. Your 
performance (frame rate) will of course vary depending on your hardware specifications 
and your selected graphics settings in FSX. 
 
 

Software Requirements 
 
The DC-9 Classic requires Service Pack 2 for FSX to be installed. 
 
Updates for FSX can be downloaded here: 
http://www.microsoft.com/Products/Games/FSInsider/downloads/Pages/default.aspx 
 
 

FSX Settings 
 
The DC-9 Classic virtual cockpit requires the Advanced Animations option to be 
enabled. Without this option, some of the instrument parts in the VC will not animate 
correctly. 
 
FSX Menu → Options → Settings → Display → Graphics → Advanced Animations 
 
 
For optimal display of the McPhat Studios textures, both in the virtual cockpit and the 
aircraft liveries, set the following options: 
 

1. The TEXTURE_MAX_LOAD variable in the FSX.cfg file should be set to 4096 
(TEXTURE_MAX_LOAD=4096). 
 
Location of the FSX.cfg file: 
Win XP: C:\Documents and Settings\Application Data\(User Name)\Microsoft\FSX 
Vista/Win 7: C:\Users\(User Name)\Appdata\Roaming\Microsoft\FSX 
 

2. Enable Preview DirectX 10 under graphics settings. 
 
The textures will display just fine without these settings. These settings are just needed for 
the highest viewing quality. 
 
 

http://www.microsoft.com/Products/Games/FSInsider/downloads/Pages/default.aspx�
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Customer Support 
 
Please log on to http://s80.flight1.net/forums and open up a user account. Registration is 
free. Then log on to http://s80.flight1.net/forumreg.htm and register with your purchasing 
details to gain access to technical customer support through the support forum. 
 
If you are already registered at the forum as an owner of either the Super 80 or Super 80 
Pro, then there is no need to re-register. You already have access. 
 
 

http://s80.flight1.net/forums�
http://s80.flight1.net/forumreg.htm�
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